
  How to use the ePub Tidy Tool v3.0.1.0


  Introduction


  The ePub tidy tool will help tidy up ePub files that not formatted correctly. It is useful if PDF files are converted to ePub files and the converted text contains errors. It will not resolve all errors, but it can save time by automating some tidying up of the ePub file.


  This version of the plugin will work only with Sigil version 0.9.0.0 and above.


  Features


  The ePub tidy tool has the following features:


  1. Span tags


  ePubTidyTool will show the span tags in the xhtml files that you select and offers the following options:


  

  	Change span tags for italicised text to <i>...</i>


  


  	Change span tags for bold text to <b>...</b>


  


  	Change span tags that include <span style="font-variant:small-caps"> so that this style can be applied to text in ePub readers that do not recognise font-variant:small-caps


  


  	Remove other span tags that can be selected by the user.


  


  


  The class statements for the span tags are shown to help the user decide whether to remove them or not.


  2. Corrects false line breaks


  Some paragraphs end with a sentence that continues in the next paragraph. ePubTidyTool will fix some of these types of errors.


  3. Corrects incorrectly hyphenated words


  Some words may be hyphenated in error. ePubTidyTool will remove the hyphen from these words. You can specify hyphenated words from which hyphens should not be removed in a text file.


  4. Puts speeches that are on the same line on to different lines


  Sometimes a closing quote mark is immediately followed by an opening quote mark in the same paragraph. The opening quote mark and the text that follows it should have been placed in a new paragraph. ePubTidyTool will correct this error.


  5. Italics and punctuation marks


  Sometimes, for example, in speeches, the first quote mark may be italicised but not the second quote mark. For consistency there is an option to remove italics from any punctuation marks at the beginning and end of speeches.


  6. Miscellaneous errors


  ePubTidyTool will correct a number of errors including those where apostrophe's point in the wrong direction, removing spaces that should not be present and replacing two or more hyphens that are together with a single long hyphen.


  7. Reformat chapter titles


  ePubTidyTool will allow chapter titles to be reformatted by stripping out existing tags that are applied to chapter titles and applying a standard header tag <h...> that you can choose. The style for the header tag can be set in a css style sheet.


  8. Reassign header tags


  ePubTidyTool enables you to rename <h...> tags in selected html files and strip out all other tags. This enables you to define the characteristics of the header tags in a css style sheet without any other tags affecting the required style.


  9. Resize images


  ePubTidyTool will allow the size of images to be made larger or smaller. This is particularly useful for cover images that may be too small.


  10. Customised error list


  You can customise two different lists for correcting words:


  (i) Some words that are processed by an OCR package are repeatedly misspelt in the same way. You can provide a customised list of these misspelt words and their corrections. This words in this list are corrected automatically by the plugin.


  (ii) Some words may be accepted by the spell checker because they are spelt correctly but an incorrect word is used. For example, sometimes the word "modern" is read by an OCR package as "modem". In this case the words need to be checked manually. You can provide a list of these words for the plugin to process. It will find each of these words and present the paragraph that contains it, together with an alternative. You can then select the alternative or retain the original word.


  11. Import a css file


  ePubTidy can import a named css file automatically so that your preferred styles can be applied to the text in your ePub book. This feature should only be used with Sigil version 0.9.1 or higher as a bug in Sigil 0.9.0.0 can corrupt the ePub book when a CSS file is loaded.


  12. Check for updates


  The plugin will automatically check the mobile read forums for updates for this plugin.


  13. Formats the code


  The plugin will format the code in Code View. This is an option that can be switched off. I included it because I wanted to be able to format the text in a particular way.


  Warning


  Make sure that you have a backup of your ePub file before running this plugin.


  THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OF THIS SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


  Licence


  This plugin is placed in the public domain. It may be modified for any purpose on condition that any derivative works are also placed in the public domain with this condition attached.


  Pre-requisites


  Unlike previous versions of this plugin, it is not necessary to install Python 3, PILlow and BeautifulSoup as Sigil 0.9.0.0 and above includes all the required libraries.


  Installation


  If you have a previous version of this plugin installed on your computer then it is recommended that you delete the old files for it by selecting Preferences from the Edit menu in Sigil and clicking Open preferences location. Open the folder plugins_prefs and delete the folder ePubTidyTool and all its contents. Also delete the the folder ePubTidyTool and all its contents from the plugins folder.


  To install the plugin, open Sigil and select Manage plugins from the Plugins menu.


  Click Add plugins.


  Navigate to the location of the plugin zip file named ePubTidyTool_vxxxxx where xxxx represents the issue number and open it.


  Click OK.


  Installing a dictionary to correct hyphenated words


  Versions of ePub Tidy prior to 0.2.0.0 required that you installed a dictionary to correct hyphenated words as the spell checker built into Sigil version 0.8.7 (and below) was not accessible from plugins. However, plugins from Sigil version 0.9.0.0 onwards can access the Sigil dictionary so versions of ePubTidyTool from 0.2.0.0 onwards use the dictionary provided by Sigil. The dictionaries provided are English (UK and USA), French, German and Spanish. To use a dictionary built into Sigil, tick the box marked Use in-built dictionary and then select the desired language from the drop-down box. If the box marked Use in-built dictionary is unticked then an external dictionary can be used and the drop-down box will become inaccessible.


  If you need to use a Hunspell Greek dictionary then you will need to add the files for this dictionary to the folder Hunspell_dictionaries that is located in the folder Sigil where the program is installed. On windows this will normally be: C:\Program Files\Sigil\hunspell_dictionaries.


  If you need to use a different language to those mentioned above then you will need to install a dictionary for that language as follows:


  Create a dictionary named WordDictionary.txt that has one correctly spelt word on each line. Dictionaries are available on the web. Save this file in UTF-8 format.


  Install this dictionary in the folder called user_dictionaries. This folder may be found by selecting Preferences from the Edit menu in Sigil, then clicking the button Open preferences location. Ensure that you leave the box marked Use in-built dictionary unticked to use the external dictionary.


  Running the plugin


  From the Plugins menu in Sigil select Edit followed by ePubTidyTool.


  Click the Start button to run the plugin.


  A window will open showing a list of xhtml files in your ePub book on the left hand side. If you have selected any xhtml files in Sigil then these files will be highlighted in the list.


  Note - files that are not correctly listed in the file content.opf will not appear in this list. For example, if the media type is not defined as media-type="application/xhtml+xml" for an xhtml file in the text section of the ePub then then this error will prevent that file from appearing in the list.


  You will also see some tick box options on the right and several buttons. These options and buttons are explained in the following sections.


  Amending ePub text and tags


  Files that are selected in Sigil will be highlighted in the list. You can change the selection as follows. Select additional files that you want to process by holding down the control key and left-clicking on them in the list. To select multiple files, hold down the control key when left-clicking. To select a range of files, click on the first one then, holding down the shift key, click on the last one in the range. To select all files hold down the control key and press the key A. To remove a file, hold down the control key and click on the file to remove it.


  The next step is to select the required options.


  Options for amending ePub text and tags


  The first seven options for amending ePub text and tags use check boxes; the remainder use push buttons that open dialog boxes where you can set up options or select files used to process text in the ePub.


  1. Fix ALL broken line endings


  The end of some paragraphs have a sentence that continues in the next paragraph. ePubTidyTool will automatically fix some of these errors, but not all of them. For example, the following will not be repaired automatically:


  I went to


  California for my holiday.


  The automated process will detect the capital 'C' at the start of the second paragraph and assume that a full stop was omitted from the end of the previous sentence. However, ticking the option Fix ALL broken line endings will correct this type of error. Be wary of the fact that if your ePub has a lot of paragraphs where the full stop has been incorrectly omitted then if this option is selected, those paragraphs will be joined together. Before ticking this option, it is best to do a quick visual inspection of the xhtml files that you want to process to see whether full stops are frequently omitted.


  2. Replace HTML


  This option will replace some html code eg &mdash; with a single character eg '—'. Replacements include  &nbsp; However, some ePub readers will not show the following as a blank line:


  <p><br /></p>


  so the plugin will insert an html space in this paragraph to ensure that it is shown as a blank line:


   <p>&nbsp;<br /></p>


  3. Process italics


  Ticking this option will put leading and trailing punctuation marks for italicised phrases outside those phrases.


  4. Process span tags


  If this option is ticked, then when the OK button is clicked, a dialog box will open showing you the definition of the span tag classes on the left-hand side of the dialog box. The right-hand side lists each of the span tags with the number of times they appear in the previously selected files in brackets. There is a drop-down box next to each tag offering the following options:


  No action - leave the tag alone


  Delete tag - delete the span tag


  Change to <i> - replace the span tag with <i>....</i>


  Change to <b> - replace the span tag with <b>....</b>


  Change to small uppercase -  Sometimes text at the start of a chapter is capitalised and the size of the font is smaller than that of the main text. This uses the style "font-variant:small-caps" which is not recognised by some ePub readers. The option Change to small UPPER changes the text that has this style to upper case and puts the span tag <span class="smallType"> around the capitalised text. This allows the user to define a class smallType in a css file to allow a smaller size font to be applied to the capitalised text.


  Change to uppercase - changes text between <span style="font-variant:small-caps"> and </span> to upper case (useful for ePub readers that do not recognise the style "font-variant:small-caps")


  Change to small uppercase italics - changes text between <span style="font-variant:small-caps"> and </span> to upper case and puts the span tag <span class="uCaseSmallItalics"> around the capitalised text. This allows the user to define a class uCaseSmallItalics in a css file to allow a smaller size font that is italicised to be applied to the capitalised text (useful for ePub readers that do not recognise the style "font-variant:small-caps").


  5. Do manual word check


  Some words may be accepted by the spell checker because they are spelt correctly but the word itself may be incorrect because it used in the wrong way. For example, sometimes the word "and" is read by an OCR package as "arid". It is not possible for ePubTidyTool to automatically correct these words; however, ePubTidyTool can show each suspect word and give you the option to change it. The words are taken from a file that you build yourself (details given later).


  6. Insert css file


  This allows the plugin to automatically load a selected css file into your ePub book so taht you can format the ePub using your own preferrred styles.


  7. Process Greek characters


  ePubTidyTool will process Greek text; unfortunately English punctuation marks can interfere with some of the Greek processing functions. Ticking the option Process Greek characters only will ensure that English characters do not affect the processing of Greek text.


  8. Format HTML


  ePubTidyTool will format the code shown in Code View if you tick the box marked Format HTML. I included this code to format the view in my preferred way; you can untick the box if you do not want to use this option.


  9. Change header tags


  Header tags such as <h3> can be changed to eg <h1> in selected html files. This will remove all other tags associated with the header so that the text between the header tags may be styled using a css style sheet.


  To use this tool click the button marked Process header tags in the Epub tidy dialog to open another dialog box named Header tags. This dialog shows a list of all permitted header tags. Next to each header tag is a drop-down box. To change a header tag, select the new header tag that is required from drop-down box.


  When you have made your choices click OK. To cancel the process click Cancel. If you press cancel the header tags will not be changed. The dialog box will close and you will be returned to the main dialog labelled Epub tidy. When you click the button marked Process text in this dialog, the ePub tidy tool will process the header tags.


  Tip: To strip out all the tags from a header tag eg <h3> without changing the header tag itself just select the same header tag (<h3>) from the drop down box.


  Using a customised list of words that are corrected automatically


  Sometimes OCR software misspells some words consistently eg gendy instead of gently. ePubTidyTool will allow you to define a list of commonly misspelt words and the required correction.


  (a) To create a list of misspelt words and the required correction, open a blank text file. On the first line put the misspelt word followed by the pipe character (|) and then the correct version of the word eg:


  gendy|gently


  Put the next error and the corrected word on the next line separated by the pipe character. Continue adding words in this way to make your list.


  Incorrect and corrected words may contain an apostrophe. For example:


  he'U|he'll


  This corrected word can be entered with a straight apostrophe (') in your list of words. ePubTidy will determine whether or not to change the straight apostrophe to a curly apostrophe (’) by analysing the content of the selected files. If you install beautiful soup (appendix 1) then the plugin will accurately determine which type of apostrophe to use; otherwise it will make a reasonable 'guess' to determine which apostrophe to use.


  (b) Save the file in utf-8 format.


  (c) To make your list available to the plugin, click the button marked Select files in the Epub tidy dialog to open a dialog box labelled Files. Click the button at the end of the row labelled Automated spelling check to open a standard file selection dialog box, select the file that you have just created, and click OK to close the standard file selection dialog box. Click OK in the Files dialog box to close it and return you to the main dialog labelled Epub tidy. When you click the button marked Process text in this dialog, the ePub tidy tool will process the words in your text file.


  The plugin remembers the name and location of your text file. It will use the same text file next time you run the plugin. You can select a different text file next time you run the plugin by clicking the button marked Select files in the Epub tidy dialog and selecting a file to use as before. This may be useful if, for example, you process different ePub books that use different languages.


  Using a customised list of words to be corrected manually


  Some words may be accepted by the spell checker because they are spelt correctly but an incorrect word is used. For example, sometimes the word "modern" is read by an OCR package as "modem". In this case the words needs to be checked manually. You can provide a list of these words for the plugin to process. It will find each of these words and present the paragraph that contains it, together with an alternative. You can then select the alternative or retain the original word.


  (a) To create a list of misspelt words and the required correction, open a blank text file. On the first line put the word to find followed by the pipe character (|) and then the alternative version of the word eg:



  modem|modern


  Put the next pair of words on the next line separated by the pipe character. Continue adding words in this way to make your list.


  (b) Save the file in utf-8 format.


  (c) To make your list available to the plugin, click the button marked Select files in the Epub tidy dialog to open a dialog box labelled Files. Click the button at the end of the row labelled Manual spelling check to open a standard file selection dialog box, select the file that you have just created and click OK to close the standard file selection dialog box. Click OK in the Files dialog box to close it and return you to the main dialog labelled Epub tidy.


  The plugin remembers the name and location of your text file. It will use the same text file next time you run the plugin. You can select a different text file next time you run the plugin by clicking the button marked Select files in the Epub tidy dialog and selecting a file to use as before. This may be useful if, for example, you process different ePub books that contain different languages.


  To run the manual spelling check, you must tick the box marked Do manual word check. Then when you click the button marked Process text in the Epub tidy dialog the ePub tidy tool will open a dialog box to display suspect words in a text box. Each suspect word is highlighted in yellow. The alternative word from your file is displayed below the text box. To replace the highlighted word with the alternative word click Change word. To keep the highlighted word click Ignore word. The next suspect word will be displayed (sometimes after a brief pause) to enable you to process the next suspect word. When all the suspect words have been processed the dialog box that displays the suspect words will close automatically.


  ePubTidyTool will remember the status of the tick box Do manual word check next time you run the plugin.


  The plugin also remembers the name and location of your text file. It will use the same text file next time you run the plugin. You can select a different text file next time you run the plugin by clicking the button marked Select file for manual word checks in the Epub tidy dialog and selecting the file to use. This may be useful if, for example, you process different ePub books that use different languages.


  Note 1: The code that implements the manual word check is slow compared to the automatic search. When you press a button to accept/reject changing a word, there may a brief pause while the plugin finds the next paragraph that contains a suspect word. Despite this, it is faster to use the plugin than to use the normal Find/Search facility that is built into Sigil where you would need to manually enter each word that could be suspect and also this risks leaving some out!


  Note 2: This feature uses Beautiful Soup. Beautiful Soup will change all html characters eg &lsquo; to a single character (in this case, a left single quote mark) when it processes text. To ensure that the text processed by Beautiful Soup matches the html file exactly, it is necessary to tick the box Replace HTML code eg &msdash; to find all suspect words. This will change html characters in the ePub to single characters that are used in the search.


  Using a customised list of hyphenated words that must not have the hyphen removed by this plugin.


  One of the features of this plugin is that it will remove hyphens between words that are not hyphenated in the dictionary. Although this is a useful feature, it sometimes removes hyphens between words that need to retain the hyphen, for example, technical words.


  You can create a list of hyphenated words that must retain the hyphen and store these in a file. The plugin will access this file to determine which words must retain the hyphen between them in your ePubs.


  The file can be created manually. The plugin can also display the hyphenated words that are in an ePub and you can select which of these, if any, to add to your list of required hyphenated words. This list of hyphenated words will then be available to use in other ePubs.


  1. Manually creating a list of required hyphenated words


  Put a list of words that must keep the hyphen between them in a text file as follows: 


  (a) Open a blank text file and put each pair of hyphenated words on a new line.


  (b) Save the file in utf-8 format with the extension txt.


  (c) To make your list available to the plugin, click the button marked Select files in the Epub tidy dialog to open a dialog box labelled Files. Click the button at the end of the row labelled Hyphen file to open a standard file selection dialog box. Select the file that you have just created and click OK to close the standard file selection dialog box. Click OK in the Files dialog box to close it and return you to the main dialog labelled Epub tidy.


  The plugin remembers the name and location of your file. It will use the same file next time you run the plugin. You can select a different file next time you run the plugin by clicking the button marked Select files in the Epub tidy dialog and selecting a file to use as before. This may be useful if, for example, you process different ePub books that contain different languages.


  2. Appending hyphenated words from an ePub file


  It can be tedious to compile the file of hyphenated words manually. This plugin can display all the hyphenated words in an ePub next to a checkbox. You can tick the boxes next to the words that must remain hyphenated and this plugin will add the selected words to your file of hyphenated words.


  First follow the procedure in the section Manually creating a list of required hyphenated words to create a file that contains at least one hyphenated word.


  To display all the hyphenated words in your ePub, run the plugin and click the button Hyphenated words.


  This opens a dialog box that lists all the hyphenated words in your ePub next to a checkbox. To add any of these hyphenated words to your list of words that must retain the hyphen tick the box next to the hyphenated words.


  If you want to add most of the displayed hyphenated words to your list, you can click the button Tick all to tick all the hyphenated words in the list and then untick those hyphenated words that are not required in your list.


  Clicking Untick all will remove the ticks from all the boxes.


  After selecting the hyphenated words click Save selection. This closes the dialog box and saves the ticked hyphenated words to your file of words that must retain the hyphen.


  Click the Close button if you want to close the dialog without saving any of the words you ticked.


  3. Removing hyphenated words from your file of hyphenated words


  Hyphenated words must be removed from the file manually by opening the text file and deleting unwanted hyphenated words from the file. Do not leave a blank line in place of the deleted words. Save the amended file in utf-8 format.


  4. Notes about the file of hypehanted words


  

	If your ePub has a lot of hyphenated words to add to your file of hyphenated words, it may be useful to backup your file containing these words before adding the new words to your file.


	As your file of hyphenated words becomes larger, this will slow down the process of checking words that are hyphenated. For this reason you may want to have different files containing hyphenated words for different types of ePubs.






  Formatting chapter headings


  ePubTidyTool includes a tool to help you to format chapter headings.


  The tool can format chapter headings that are spread over one or two lines. For example:


   



  Chapter 1


  A Cold Morning


   



  Sometime the chapter number is on a line by itself. For example:


  1


  A Cold Morning


  You can use the tool to give chapter headings a standard header tag (<h1>, <h2>, <h3>, etc) that can be styled using a css stylesheet.


  To use this tool click the button marked Options for chapter titles in the Epub tidy dialog to open another dialog box named Format chapter titles. This dialog is divided into three sections labelled General, First line of chapter and Second line of chapter.


  In the section General, select the format for the chapter heading in the book. If the chapter heading is a number on a line by itself, select Numeric only. If the chapter heading starts with a Roman numeral select Roman (start). Headings containing Roman numbers that are not at the start of a line cannot be processed. If the chapter heading starts with Chapter select Text. If the chapter heading starts with a number select Numeric (start).


  Important: Use the options Roman (start) and Numeric (start) with care. It is best to apply these options to tags that are not paragraph tags (<p> and </p>) because a normal paragraph may begin with the pronoun I and this will be treated as a heading that starts with a Roman number. Similarly, a normal paragraph that starts with a number will be treated as a heading that starts with a number.


  This tool can insert Sigil split markers at the start of every chapter. To insert these markers, tick the box labelled Insert chapter breaks (You will need to run Split at markers from the Edit menu in Sigil to split the chapters at the marked points). The marker is not inserted for chapter headings that follow immediately after the <body> tag to avoid producing blank pages.


  Select the tag that surrounds the chapters in your book from the selection box labelled Select tag used for chapters in the section First line of chapter.


  Select the tag that you want to apply to the chapter heading from the selection box labelled Select tag required for chapters.


  Select the case that you want to apply to the title using the selection box labelled Required case. Three options are available:


  

  	Title case - this capitalises the first letter of every word in the heading.


  


  	Upper case - this capitalises every letter in the heading.


  


  	Capitalise first character - this capitalises the first character of the title only - allow other letters will be in lower case.


  


  


  Remember that this is a tool to save time and it is not perfect. It cannot recognise place names, so if you choose Capitalise first character then, for example, if London is not the first word in the title of the chapter, it will appear as london. Similarly, if you apply Title case to a heading, then some words that are not usually put in title case will have the first letter of the word capitalised. The following words will not be capitalised: 'the', 'a', 'as', 'in', 'of', 'an' and 'and'.


  If the chapter heading consists of two lines that follow each other then you can also format the second line as follows:


  Tick the box labelled Chapter title covers two lines in the section Second line of chapter. The settings in this section will become ungreyed. The same options apply as before to the second line of the chapter heading:


  Select the tag that surrounds the chapters in your book from the selection box labelled Tag for second line is.


  Select the tag that you want to apply to the chapter heading from the selection box labelled Required tag for second line is:.


  Select the case that you want to apply to the title using the selection box labelled Required case for second line is:. The three case options are available as for the first line.


  Roman numerals in headings


  When using titlecase, to prevent first character of a Roman numeral from appearing as uppercase and the remaining characters in lowercase, there is an option in the General section of Format chapter titles to set the required case as Upper or Lower.


  When you have made your choices click OK. To cancel the process click Cancel. If you press cancel the chapter headings will not be changed. The dialog box will close and you will be returned to the main dialog labelled Epub tidy. When you click the button marked Process text in this dialog, the ePub tidy tool will run and process chapter heading as required.


  Loading a css style file


  Warning: This feature was suspended for Sigil 0.9.0.0 as a bug in this version of Sigil can cause the ePub book to become corrupted. The feature has been reinstated, but should not be used for Sigil version 0.9.0.0


  You may prefer to use your own styles for your ePub books; certainly you will need to define styles if you are using the styles that ePubTidyTool applies such as the smallType style that is discussed elsewhere. ePubTidyTool provides an option so that you can load a CSS style sheet that contains your preferred set of styles automatically.


  It is recommended that you set up the styles in a style sheet in Sigil, test them, and then export the css style sheet to a file that can then be loaded by ePubTidyTool. To export a style sheet from an ePub in Sigil right click the css style sheet in Sigil and select Save as.


  To select the css file to be imported click Select files in the Epub tidy dialog to open a dialog box labelled Files. Click the button at the end of the row labelled CSS file to open a standard file selection dialog box, select the css file that contains your styles and click OK to close the standard file selection dialog box. Click OK in the Files dialog box to close it and return you to the main dialog labelled Epub tidy.


  To import the selected style sheet, you must tick the box marked Insert CSS file. Then when you click the button marked Process text in the Epub tidy dialog the ePub tidy tool will add your css file to your ePub book if that file is not already present.


  As some users may not want to apply this style to every text file in the ePub book, ePubTidyTool will not automatically associate the imported css style sheet with each text file in your ePub; you will need to do this manually.


  ePubTidyTool will remember the status of the tick box Insert CSS file next time you run the plugin.


  The plugin also remembers the name and location of your style sheet file. It will use the same file next time you run the plugin (if the box marked Insert CSS file is ticked). You can select a different text file next time you run the plugin by clicking the button marked Select CSS file in the Epub tidy dialog and selecting the file to use. This may be useful if, for example, you process different ePub books that need different style sheets.


  Resizing images


  ePubTidyTool has a facility for changing the size of an image. The user can set a new width for the image and the height will be increased in the same proportion to retain the aspect ratio.


  To resize an image click the button marked Resize image. The dialog box with the caption Adjust image size will open. A list of images in the ePub file will be shown. Click the image you want to change. The image will be shown with a default width of 480 pixels on the right hand side of the dialog (this is the size I use for my ePubs!). Enter the new width in pixels in the entry box. This box will only take numbers; if you type any other character a warning beep will sound and the character will not be added to the box. After entering the required width for the image, click Show resized image. If the width entered is larger than 1000 pixels the image shown will be set to 1000 pixels.


  The image shown will be updated to show the new size. This will give you an idea of the quality of the image. To replace the original image in the ePub book, click the OK button. If you change your mind click the Cancel button.


  Checks for updates


  When you run the plugin it will check the web to find out whether an update is available. A message will be displayed in the Sigil Plugin runner window to let you know whether the installed plugin is current or whether an update is available. If an update is available a dialog box will open that will enable you to either go to the Mobile Read web page where the updated version can be downloaded or gives an option to remind you later. You will need to download and install updates manually. The plugin will let you know when the reminder will next appear if you do not update the plugin.


  Report on changes made


  The Sigil Plugin runner window will display some changes made to the text in the ePub book, for example, it lists words from which the hyphen has been removed. This will not include chapter headings, images that have been changed or any words that have been corrected using the manual spelling checker.


  Ελληνικές Διορθώσεις


  

  	Διορθώνει τις τρεις τελείες (...) σε …


  


  	Διορθώνει το ΐ] σε η


  


  	Διορθώνει το σιη σε στη ακόμα και όταν είναι μέρος λέξεων, από τις δοκιμές που έχω κάνει είναι ασφαλές.


  


  	Διορθώνει τα οτη, οτο, οτον, οτα, οις, οην σε στη, στο, στον, στα, στις, στην μεμονομένα, όχι μέρη λέξεων.


  


  	Διορθώνει τα τοιν, τιον σε των.


  


  	Διορθώνει το οιί σε ού


  


  	Διορθώνει το σιις σε στις


  


  	Διορθώνει τα σιο, σιου, σια σε στο, σου, σα


  


  	Διορθώνει τα ο'ι σε ώ


  


  	Διορθώνει τα γΓ, γΡ σε γι’


  


  	Διορθώνει το νπ σε ντι


  


  	Διορθώνει το ΓΓ σε Γι’


  


  	Μετατρέπει σε τονισμένα τα κεφαλαία φωνήεντα πχ τα 'Α, "Α σε Ά


  


  	Μετατρέπει τα ΰ σε ύ, μερικά μπορεί να είναι λάθος αλλά είναι ελάχιστα.


  


  	Διορθώνει το ε' σε έ


  


  	Βάζει κενό μετά από το τελικό σίγμα (ς) που ακολουθείται από γράμμα.


  


  	Διορθώνει τα Π που είναι σαν 1 Ι,1Ι, ΓΙ, Γΐ, II, Ι Ι, ΓΤ, ΙΊ, Ιίεφόσον η λέξη που εμπεριέχονται υπάρχει στο λεξικό. Αλλιώς το αφήνει ώς έχει.


  


  	Διορθώνει τα έ που είναι σαν ύ εφόσον η λέξη που εμπεριέχονται υπάρχει στο λεξικό. Αλλιώς το αφήνει ώς έχει.


  


  


  ΠΡΟΣΟΧΗ: Για τις διορθώσεις 17 και 18 καλό είναι να τσεκάρετε τις λέξεις που έγιναν οι αλλαγές. Θα φαίνονται στο παράθυρο του Plugin ως FixP: FixE:



  What is new?


  What is new in version 0.3.0.1.0?


  

  	Previously you could manually specify hyphenated words from which the hyphen must not be removed. This update displays a list of hyphenated words in an ePub that are not in your existing list of required hyphenated words. You can select which of the displayed hyphenated words you want to add to your list by ticking boxes next to the words that must be hyphenated.


  	Removes spaces following the tag <p>


  	Removes line breaks between the tags <p and </p>


  


  What is new in version 0.3.0.0.0?


  

  	You can specify hyphenated words from which the hyphen must not be removed.


  	More hidden codes are removed from the eBook


  	Has code to format the xhtml files. This feature can be switched off.


  	Inserts tags <colgroup> and </colgroup> in tables where they are missing.


  	Removes blank lines immediately following the <p...> tag.


  	Has new code for checking whether a new version of Sigil is available that presents a dialog box to enable you to either go to the donwload page for the plugin or ask to be reminded again later.


  


  What is new in version 0.2.0.0.5B?


  

  	The plugin runs automatically when opened.


  	The box Select parts to process now includes a scrollbar


  


  What is new in version 0.2.0.0.5A?


  

  	Plugin will only run if the version of Sigil is 9.1 or greater; there is a risk that a bug in Sigil version 0.9.0 will corrupt your eBook so the plugin will only work if the version of Sigil is 9.1 or greater.


  	Plugin has been updated with code from Steadyhands. The updated code will not run if quotes used for speech are single curly quotes.


  


  What is new in version 0.2.0.0.5?


  

  	Plugin now checks for updates on the web and informs you if an update is available.


  	Plugin checks more words with an apostrophe in the wrong direction eg ‘oney; the case of words is ignored with thanks to Steadyhands.


  	Some internal code has been simplified


  


  What is new in version 0.2.0.0.4A?


  

  	Bug fix: The line for FixP has a missing round bracket. This has been corrected.


  


  What is new in version 0.2.0.0.4?


  

  	Plugin can load a named css style sheet again; I had disabled this feature because Sigil version 0.9.0 had a bug that caused this feature of the plugin to corrupt ePub books. The bug has been fixed in Sigil version 0.9.1. and higher.


  


  What is new in version 0.2.0.0.3?


  

  	Bug fixed: Changing forward slashes incorrectly to an apostrophe fixed


  	Additional amendments for processing Greek texts from gipsy including a fix for φ


  


  What is new in version 0.2.0.0.2?


  

  	Bug fixed: The spell checker for the Greek Hunspell dictionary should work correctly


  	Bug fixed: The count of the number of words from which the Hyphen is removed should be correct.


  


  What is new in version 0.2.0.0.1?


  

  	The ability to process chapter headings has been extended to include headings that start with either a number or Roman numerals


  	Support for a Greek Hunspell dictionary is included.


  


  What is new in version 0.2.0.0?


  

  	Takes advantage of the new facilities in Sigil version 0.9.0.0 so that it is no longer necessary to install external libraries eg Beautiful Soup.


  	Files for processing can be selected in Sigil before the plugin runs; these files are highlighted in the list in the ePubTidy dialog.


  	CSS files cannot be installed by this plugin to avoid corruption to the ePub book when using Sigil version 0.9.0.0; this feature will be reinstated when the next version of Sigil is released.


  


  What is new in version 0.1.1.6?


  

  	Has a new customised word list. Some words may be accepted by the spell checker because they are spelt correctly but an incorrect word is used. For example, sometimes the word "modern" is read by an OCR package as "modem". In this case the words needs to be checked manually. You can provide a list of these words for the plugin to process. It will find each of these words and present the paragraph that contains it, together with an alternative word. You can then select the alternative word or retain the original word.


  	Has an option tick box for processing Greek text


  	Fixes incorrect Greek words that have Π, ώ, ω and έ missing (fix provided by gipsy)


  


  	Has the extra option for processing span tags: Change to small uppercase italics. This changes the text that has the style "font-variant:small-caps" to upper case italics in a smaller font than normal and puts the span tag <uCaseSmallItalics> around the capitalised text. This allows you to define a class uCaseSmallItalics in a css file to allow a smaller size font to be applied to the italicised capitalised text


  


  	Has an option for importing a CSS file so that you can use your preferred format for text.


  


  What is new in version 0.1.1.5?


  

  	The html code &lsquo;, &rsquo;, &ldquo;, &rdquo;, &#39;, &ndash; and &apos; will be replaced by the single characters: ‘, ’, “, ”, ', – and ' when the option Replace HTML code eg &ndash; is ticked.


  


  	When using the customised error list to replace words containing apostrophes or quote marks ePubTidy will replace them with either straight quote or curly quotes depending on the most common type of quote marks that are found in the selected files in the ePub. The most common type of quote mark used in the ePub is determined accurately if BeautifulSoup is installed, otherwise the most common type of quote mark is estimated.


  	Bug fix: Word files that contain Greek characters are processed correctly.


  


  What is new in version 0.1.1.4?


  

  	Allows the user to use a custom list of words that need to be corrected


  	Allows the user to rename <h...> tags in selected html files and strip out all other tags


  


  	The following html codes are changed to single characters: &#8216; (‘) &#8217; (’) &#8220; (“) &#8221; (”) &#8212; (—)


  


  'xxx ’xxx ' xxx ‘ xxx “


  What is new in version 0.1.1.3?


  

  	Has the option for processing span tags Change to small UPPER. This changes the text that has the style "font-variant:small-caps" to upper case and puts the span tag <span class="smallType"> around the capitalised text. This allows the user to define a class smallType in a css file to allow a smaller size font to be applied to the capitalised text.


  	Has the option for processing span tags Change to UPPER that changes the text that has the style "font-variant:small-caps" to upper case


  


  What is new in version 0.1.1.2?


  

  

  	Bug fix: Sometimes a line containing a chapter title would join with the following line - this has been corrected.


  	Sigil split markers are no longer placed after a <body> tag as there is no point in splitting a page at this point.


  	Corrections to Greek text can be made.


  	Images in an ePub can be resized.


  


  


  What is new in version 0.1.1.1?


  

  	Bug fix: The program no longer hangs in Linux.


  


  	When chapter headings contain Roman numerals the user can set these to upper or lower case when applying titlecase to the heading.


  


  	When titlecase is used, some words normally start with in lowercase e.g. 'the'. Some words will now appear in lowercase.


  	Corrects the direction of a quote mark at the end of a paragraph.


  


  What is new in version 0.1.1?


  Added: New corrections to words that have erros when scanned into a PDF file :


  

  	Fixes 'th' when PDFd as 'lli'


  


  	Fixes 'thing(s)' when PDFd as 'tiling(s)


  


  	Fixes 'their' when PDFd as 'tlieir'


  


  	Fixes 'she' when PDFd as 'slie'


  


  	Fixes 'when' when PDFd as 'wlien'


  


  


  Added: Tool to format chapter titles

